
PEACE RIVER REGIONAL DISTRICT
ELECTORAL AREA DIRECTORS COMMITTEE MEETING

A G E N D A
for the meeting to be held on Thursday, September 11, 2014 in the

Regional District Office Boardroom, 1981 Alaska Avenue,
Dawson Creek, BC, commencing at 10 a.m.

1. Call to Order:  Director Goodings to Chair the meeting

2. Director’s Notice of New Business:

3. Adoption of Agenda:

4. Adoption of Minutes:
M-1 Electoral Area Directors’ Committee Meeting Minutes of August 14, 2104.

5. Business Arising from the Minutes:

6. Delegations:
D-1 Outlook Calendaring Webinar (1 hour)

7. Correspondence:
C-1 August 29, 2014 email from Wendy Davis, Branch Manager, BC SPCA South Peace Branch

regarding Feral Cat Shelters and Feeding Stations for Aspen Trailer Park

8. Reports:
R-1  September 9, 2014 report from Chris Cvik, Chief Administrative Officer, regarding Sub-regional

Water Function and Sub-regional Septage Handling Function

9. New Business:

10. Diary:

11. Adjournment:
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PEACE RIVER REGIONAL DISTRICT
ELECTORAL AREA DIRECTORS’ COMMITTEE

MEETING MINUTES

DATE: August 14, 2014
PLACE: Regional District Office Boardroom, Dawson Creek, BC
PRESENT:

Directors: Karen Goodings, Electoral Area ‘B’ and Meeting Chair
Arthur Hadland, Electoral Area ‘C’
Leonard Hiebert, Electoral Area ‘D’
Jerrilyn Schembri, Electoral Area ‘E’

Staff: Chris Cvik, Chief Administrative Officer
Shannon Anderson, Deputy Chief Administrative Officer
Bruce Simard, General Manager of Development Services,
Fran Haughian, Communications Manager / Commission Liaison
Trish Morgan, Manager of Community Services
Jeff Rahn, General Manager of Environmental Services
Kari Bondaroff, Manager, Invasive Plant Program
Barb Coburn, Recording Secretary

Call to Order Chair Goodings called the meeting to order at 10 a.m.

ADOPTION OF AGENDA:
August 14, 2014 Agenda MOVED by Director Hadland, SECONDED by Director Hiebert,

That the Electoral Area Directors’ Committee agenda for the August 14, 2014 meeting, be
adopted, including items of new business:
Call to Order:  Director Goodings to Chair the meeting
Directors’ Notice of New Business:
Adoption of Agenda:
Adoption of Minutes:
M-1 Electoral Area Directors’ Committee Meeting Minutes of July 17, 2014
Business Arising from the Minutes:
BA-1 Discussion regarding the General Manager, Electoral Area Admin Position
Delegations:
Correspondence:
Reports:
R-1 July 23, 2014 Report from Director Leonard Hiebert, Electoral Area ‘D’ regarding Attendance at the

2014 Federation of Canadian Municipalities Conference.
R-2 July 23, 2014 Report from Bruce Simard, General Manager of Development Services regarding the

Building Bylaw.
R-3 Fran Haughian, Communications Manager/Commission Liaison regarding Nomination Period

Communications for the General Local Elections.
R-4 Jeff Rahn, General Manager of Environmental Services regarding the Invasive Plant Program
New Business:
NB-1 Work Camps
NB-2 Wasting Disease
NB-3 Telus Request
NB-4 Sewer Creek near Old Fort
NB-5 Weeds Complaints in Charlie Lake
NB-6 North Peace Landfill Complaint
NB-7 Bissette Creek
NB-8 Swan Lake Enhancement Society
Diary:
Adjournment:

CARRIED.
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ADOPTION OF MINUTES:
M-1
EADC Meeting Minutes of
July 17, 2014

MOVED by Director Hadland, SECONDED by Director Schembri,
That the Electoral Area Directors’ Committee minutes of July 17, 2014 be adopted.

CARRIED.

BUSINESS ARISING:
BA-1
NB-2 - General Manager
Electoral Area Admin
Position

The Directors reviewed the duties and responsibilities for the General Manager Electoral Area
Administration as supplied by Leah Mellott of the Regional District of North Okanagan.  It was
determined that the duties and responsibilities of the new employee should be:
1. act as staff liaison for the Electoral Area directors - provide advice, research and draft

documents, oversee calendars, coordinate activities, and coordinate attendance at elected
official engagements;

2. attend EADC meetings in the capacity of staff liaison; assist with formulation of
recommendations to the Board;

3. Prepare reports, briefs, plans and background documentation for EADC meetings and
oversee preparation of meeting agendas;

4. Initiate action, coordinate and monitor assigned tasks emerging from meetings.
5. work with directors and staff to formulate recommendations with respect to policies,

procedures, bylaws, programs, budgets and long-term planning;
6. monitor budget and approve expenditures;
7. contribute as a member of the senior management team;
8. maintain harmonious working relationships with municipal and regional district staff, elected

officials, members of the business community and the general public;
9. perform other duties as may be assigned from time to time;
10. undertake emergency training and assist as directed in supporting the regional district’s

emergency response mandate; and
11. duties assigned during an emergency may differ from regular duties.

MOVED by Director Hadland, SECONDED by Director Hiebert,
That the Electoral Area Directors’ Committee recommend that staff research the General
Manager Electoral Area Administration Position, prepare a job description and summary report to
be presented to the Regional Board for approval.

CARRIED.

REPORTS:
R-1
Building Bylaw

MOVED by Director Hadland, SECONDED by Director Hiebert,
That the Electoral Area Directors’ Committee recommend to the Regional Board that meetings be
arranged with key interested parties to review and compare the proposed new building bylaw to
the old bylaw prior to presenting Building Bylaw No. 2131, 2014 to the Regional Board.

CARRIED.

MOVED by Director Hadland, SECONDED by Director Hiebert,
That the Electoral Area Directors’ Committee recommend to the Regional Board that, after the
pre-meetings have been held, public information sessions be held in each electoral area to review
Building Bylaw No. 1189, 1999 with the proposed Building Bylaw No. 2131, 2014.

CARRIED.

Recess The meeting recessed for lunch at 12:25 p.m.
Reconvene The meeting reconvened at 12:55 p.m.
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REPORTS (CONTINUED):
R-3
Communications during the
nomination period of the
2014 election.

MOVED by Director Hadland, SECONDED by Director Schembri,
That the Electoral Area Directors’ Committee recommend to the Regional Board that the
communications strategy to hold information sessions in the Dawson Creek and Fort St. John
Regional District offices for the 2014 Local General Election nomination period be approved as
follows:
- develop an elections 2014 page on the Regional District website;
- perform regular posts to the Regional District Facebook page;
- create an outline of “What Every Candidate Needs to Know” that the Corporate Officer can

present at the information meetings; and
- include advertising, in addition to the statutory requirements, on the following local radio/TV

stations and websites:
 - Peace FM and Chet TV;
 - Bell Media, Dawson Creek;
 - Moose FM, Fort St. John; and
 - Energetic City website.

CARRIED.

NEW BUSINESS:
NB-2
Chronic Wasting Disease

MOVED by Director Hadland, SECONDED by Director Schembri,
That the Electoral Area Directors’ Committee recommend to the Regional Board that Cait Nelson,
Wildlife Health Biologist, Fish and Wildlife Branch, Ministry of Forests, Lands and Natural
Resource Operations be invited the next Inter-provincial meeting to discuss Chronic Wasting
Disease and signage.

CARRIED.

NB-3
Telus and CRTC

MOVED by Director Schembri, SECONDED by Director Hadland,
That the Electoral Area Directors’ Committee recommend to the Regional Board that a letter be
forwarded to the Canadian Radio-television and Telecommunications Commission (CRTC) to
express concerns regarding the review of wholesale mobile wireless services, Telecom Notice of
Consultation CRTC 2014-76, stating the following:
- We understand that the CRTC is examining the Canadian mobile wireless marketplace.  We

also understand that the CRTC is considering possible mandatory wholesale access to
wireless network services to assist competitors.

- Given the importance of the issues under consideration in this proceeding and the potential
impact on availability of wireless services in Canada, we ask that you consider our views and
the potential impact of your decisions on our community.

- We ask that the CRTC ensure its framework maintains full incentives for wireless service
providers to invest in rural communities so that our citizens continue to have access to the
fastest networks.  We would not want the CRTC to institute new rules that would detract future
investment.

CARRIED.

NB-4
Sewer Creek

MOVED by Director Hadland, SECONDED by Director Hiebert,
That the Electoral Area Directors’ Committee recommend to the Regional Board that staff liaise
with the City of Fort St. John regarding erosion mitigation of the creek channel commonly known
as Sewer Creek and to enquire concerning the status of in-line hydro generators.

CARRIED.
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NEW BUSINESS (CONTINUED):
NB-5
Bissette Creek Riprap

MOVED by Director Schembri, SECONDED by Director Hadland,
That the Electoral Area Directors’ Committee recommend to the Regional Budgets Administration
Committee that the request for financial assistance for erosion mitigation measures on Bissette
Creek be approved.

CARRIED.

Adjournment MOVED by Director Hadland, SECONDED by Director Hiebert,
That the meeting adjourn.

CARRIED

The meeting adjourned at 2:25 p.m.

Karen Goodings, Chair Barb Coburn, Recording Secretary
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Microsoft Outlook: Calendaring
Managing Your and Coworkers’ Calendars by Working with 
Permissions, Delegates, and Views

The Outlook calendar can provide many people exactly the functionality they need without 
any further work. They put meetings on their calendars, take them off, and they don’t think 
any more about it. For others, being able to manage multiple calendars is critical, or sharing 
calendar information with coworkers, or automating their interaction with the calendar. For 
this, there are many customizations, tweaks, behaviors, and tools you can use to make the 
calendar work for you. Show multiple calendars in different views, share your calendar in 
multiple ways, adjust the settings for your delegates, or just make meetings more quickly 
than others do. Topics discussed in this session include:

•	 Drag-and-Drop Action Items

•	 Automating Meeting Creation

•	 Scheduling in Multiple Time Zones

•	 Working with Recurrence Patterns

•	 Scheduling Tools

•	 Extending Viewing Rights to Coworkers

•	 Advanced Permissions

•	 Assigning Delegates for Your Calendar

•	 Viewing Multiple Calendars

•	 Understanding Meeting Organizers

•	 Creating Calendar Groups and Custom Settings

•	 Emailing Your Calendar

 
Presenter: Neil Malek

neil@knacktraining.com
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2OUTLOOK TIPS

Automating Meeting Creation
Besides navigating to the Calendar and pressing the New button, there are several ways to 
create a new meeting.

From an Email
To turn an email directly into a meeting, click-
and-drag the email onto your Calendar icon 
or the listing mentioning Calendar in the 
bottom-left corner of the screen. This will 
open a new window where the subject line 
of a new Appointment is the subject line of 
the original email, the date and time are the 
next available time, and the body of the email 
is placed into the body of the appointment. 
Simply click the Invite Attendees button to 
turn it into a meeting, edit the date, time, 
subject, and body as necessary, and you 
have your meeting! This will retain the email 
originally in your Inbox.

As Part of a Process
In Outlook 2010 and 2013, there is a tool called a Quick Step. The purpose of this feature is to 
allow users to create buttons to execute sets of steps. So, for example:

You receive an email from a prospective client. You want to 
forward the email to your supervisor, set a meeting on the 
calendar for you and the prospective client to talk on the 
phone, and file the email into the folder Prospective Clients.

Click the New Quick Step button at the top of the screen, and 
name your process something useful (Prospective Client). 
For the first step, Forward to your boss’s email address. Add 
another step, and tell it to Reply with Meeting. Fill in any 
other details you think are repeated. Finally, add another 
step and tell it to Move to Folder. Pick the folder you like.

AD0009
D-1

AD0009
Sep.11



3OUTLOOK TIPS

Working with Time Zones
Our first point: because Microsoft Exchange uses time coding on the emails it passes to your 
Outlook, everyone’s individual computers should have the meeting appear in the appropriate 
slot for your time zone. If you find technical issues with this, it is an IT issue that needs to be 
resolved.

Scheduling Meetings in Particular Time Zones
If you’ll be traveling to a location for a meeting, and you can’t be bothered to do the 
mental math to put the time in your own time zone, click the Time Zones button 
at the top of your meeting request. This will allow you to specify the time in that 
location. Again, every person who is attending will have it placed on their calendars 
in the appropriate slot for their time zone.

Displaying the Time Zone of a Frequent Concern
If you’ve got a second location in a distant time zone, it may be beneficial to constantly see the 
conversion to their time zone. To do this, click File > Options > Calendar, and find the Time 
Zones section. Click the check box for Show a second time zone, select it and label it. From 
now on, your calendar will have the second option visible.
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4OUTLOOK TIPS

Recurrence and Scheduling Features
Recurring Meetings
To schedule a recurring meeting, first determine how the measure of time between meetings 
is decided. This may be as simple as Every Wednesday, or as complicated as The first Monday 
of every third month. Now, when scheduling your meeting, click the Recurrence button at the 
top of the screen.

The Recurrence Pattern doesn’t apply to only 
weekly or monthly options; it’s any pattern 
that can be measured in weeks or months. 
So, for example, you can choose for a meeting 
to happen Weekly, Recur every 2 weeks on 
Wednesday, and you’ve chosen to recur every 
other week on Wednesday. 

It’s often important t specify in the Monthly 
segment that it’s the first Monday, for example, 
instead of trying to specify dates.

Useful Scheduling Features
Scheduling Assistant: See all currently invited individuals, and their open slots on 
the calendar. This also gives you a selection of Suggested times in the bottom-
right corner, to see when the entire group is available again.

Room Finder: Instead of typing a selection into the Location field, choose one 
of your company’s conference rooms from the Room Finder. Not only can you 
see the availability of these locations at a glance, but by choosing a room, 
you’re booking it.

Schedule View: While looking at your (and the rest of your team’s) calendar(s), you 
can switch to Schedule View, which shows everyone’s free and busy blocks of time 
at a glance.
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5OUTLOOK TIPS

Permissions
Granting View Permissions
To allow one of your coworkers to see the contents of your calendar, simply visit your calendar 
and click Share Calendar at the top of the screen. A new email is created, you can send it 
to whomever you like, and you can click the checkbox to Request permission to see their 
calendar as well.

More Complicated Settings
If you’d like your coworker to be able to add and remove 
information from your calendar, you’ll need to dig deeper. 
Right-click your calendar and select Properties. From 
here, you’ll see a tab called Permissions.

Click Add to find and add the account of one of your 
coworkers; then, choose the appropriate settings below 
for your Permission Level. You can select one of the 
pre-determined options, or click the radio buttons and 
checkboxes to create a permission level specific to their 
job role.
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6OUTLOOK TIPS

Delegates
More Than Owner Permissions
By creating a coworker as a Delegate, you are giving them the 
permission to receive your meeting requests, to send emails 
as you, and essentially take over the management of portions 
of your Outlook. This is a powerful feature, and always 
determine whether this is the best course of action.

Adding a Delegate
Click File > Info > Account Settings > Delegate Access. This 
opens a dialog box that allows you to select the segment(s) 
of your Outlook you’d like to share access to. After adding 
your coworker, select the level of permissions shared with 
that person in each segment, and also determine whether 
(1) Delegate receives copies of meeting-related messages 
sent to me, (2) Deliver meeting requests addressed to me 
to my delegates, sending a copy to me, (3) Deliver meeting 
requests only to my delegates, or (4) Deliver to both my 
delegates and me.
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7OUTLOOK TIPS

Custom Views and Settings
What are Custom Views?
Any display of what’s happening in Outlook - Inbox, 
Calendar, wherever - is a View. By customizing an 
existing View or creating a Custom View, you allow 
yourself a different perspective on the same content.

Here’s an example: Let’s say your Calendar is 
chock-full of information, and it becomes difficult 
to manage and see everything at the same time. 
You may decide it would be useful to only see the 
meetings that your boss is attending at a particular 
time. To create a new View to do this, click View > 
Change View > Manage Views and select New...

Now, name the view something useful (Boss’s Meetings), and 
choose the Day/Week/Month type of view. After clicking OK, 
you’ll be asked to Filter... Click the button, and find the button for 
Attendees... This will allow you to choose your boss’s name. Click 
OK a few times, and you officially have a view that will only show 
you your boss’s meetings - you can switch between that and your 
Calendar view.

What Settings Can I Change?
Try it out: Click File > Options, and choose Calendar. 
You’ll see that you can change your calendar’s 
background color, default alert, workdays, holidays, 
and many other settings.
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From: Wendy Davies - South Peace Branch Manager, BC SPCA [mailto:wdavies@spca.bc.ca]
Sent: Friday, August 29, 2014 3:42 PM
To: Jerrilyn Schembri; Chris Cvik; rolf@telus.net
Subject: Aspen Trailer Park Update

Good afternoon!

On August 19, 2014 I attended a meeting with 9 residents from the Aspen Trailer park.  At that time I
provided them with building plans for feral cat shelters and feeding stations.  They agreed to begin
construction of the shelters to have prepared for my next visit on Saturday, August 30th.

Jessica Alexander agreed to arrange for garbage bins to be placed on site for the week of Sept 1st to facilitate
a community cleanup.  Jessica also agreed to prepare a list of potential donors for materials and services
required to implement the plan such as building materials, paint, sand and garbage removal.  Tomorrow I will
be spending the day at Aspen Trailer park to assist the residents in determining where the cat trouble spots are
and where care stations would be best located.

CJDC News Director, Jeremy Keefe, is preparing media support to help us educate about the importance of
proper feral cat management and care.  There will be a clip on tonight's news introducing the South Peace
TNR program that explains how people can donate in support.

I have provided documentation on how the residents can reduce or eliminate attractants that entice the cats
into the residential area.  Those present agreed to assist others to make repairs necessary to encourage the cats
to use the care stations.  This will include patching holes in trailer skirting, reducing clutter in yards where
cats may hide and eliminating outdoor food sources within the residential area.  I have made arrangements
with 2 South Peace Veterinarians to assist with the TNR project and have bartered a very good deal on
veterinary care.  For a top cost of $200/cat we will trap, spay/neuter, vaccinate, deworm, tattoo and ear tip to
make the cat easily identifiable as a colony cat.  The current cost to only spay a cat runs between $175-$200
so I can assure you we have put together an extremely good deal here.

The residents have agreed to create the care centers on their own $ but we will need assistance as previously
discussed for the actual TNR of the cats.  Due to high risk to the animals we are unable to trap in the winter
so I am hoping to begin trapping no later than September 15th.

What are the next steps required to secure some funding for us to proceed?  Thank you for your time and
support as we continue with this remarkable project.

Sincerely,

Wendy Davies, Branch Manager
BC SPCA South Peace Branch
637 114th Avenue, Dawson Creek BC V1G 3A1
Phone: 250.782.2444   Cell: 250.719.1340
wdavies@spca.bc.ca  / spca.bc.ca/southpeace

OUR MISSION: To protect and enhance the quality of life for domestic, farm and wild animals in British Columbia.

The BC SPCA is a not-for-profit organization reliant on donations from the public.
Charitable Tax # BN 11881 9036 RR0001

This message and any attachments or links are for the sole use of the intended recipient(s) and may contain privileged and
confidential information. Any unauthorized review, use, disclosure or distribution is prohibited. If you are not the intended recipient,
please notify us immediately and destroy the original message.  Thank you.

mailto:wdavies@spca.bc.ca
mailto:rolf@telus.net
mailto:wdavies@spca.bc.ca
http://www.spca.bc.ca/southpeace
http://www.spca.bc.ca/southpeace
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Peace River Regional District 
REPORT 

 

 
 
To:           Electoral Area Directors Committee (EADC)    Date: September 9, 2014 
 
From: Chris Cvik, CAO 
  
Subject: Project Update #1:  Sub-Regional Water Function and Sub-Regional Septage 

Handling Function 
 
 

 

 
 

RECOMMENDATIONS:  
 
1. That EADC adopt the attached update on the Sub-Regional Water Function and Sub-

Regional Septage Handling Function as presented. 
 
 

BACKGROUND/RATIONALE: 
 
At the July 24, 2014, PRRD Board Meeting, the Board approved the creation of a sub-regional 
water and sewage function that includes all four electoral areas within the service area.  Further to 
this, the Board approved the use of the Alternative Approval Process (AAP) for the creation of the 
sub-regional water and sewage function. 
 
The following time line is presented for review and comment.  It represents a high level overview of 
key target dates in the creation of the new services. 
 
October 2014 
 

 October 9 – PRRD Board Meeting.  Present draft service establishment bylaws to the Board 
for three readings to create the new services. Present the required Loan Authorization 
Bylaws for three readings also. Bylaws submitted for ministry approval.  

 

 October 16 – Present a draft presentation to the EADC on the Community Conversations 
presentations that will be used to let residents know about the proposed new services. 

 

 October 20 – November 30 – Conduct approximately fourteen (14) Community 
Conversation Meetings.  
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Report – EADC  
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December 2-14 
 

 December 1 – December  12 – Run required statutory public notices for two consecutive 
weeks in local newspapers and additional advertising as appropriate. 

 

 December  15 – January  14, 2015 – The thirty (30) day Alternative Approval Process (AAP) 
period for receiving elector responses is in effect. 

 
 
February 2015 
 

 February 12, 2015 – PRRD Board Meeting.  If AAP is successful, present the service 
establishment and loan authorization bylaws to the Board for consideration of adoption. 

 

 February 13 – 23 – 10 day period for notice of application to court to quash loan 
authorization bylaw  

 
 
March 2015 
 

 March 12, 2015 – PRRD Board Meeting.  Award tender for Sewage Facility for Charlie Lake.   
 

 March 26, 2015 – Alternate date to award tender for Sewage Facility for Charlie Lake. 
 
 
The timeline shown above is aggressive.  One of the key reasons for this is the desire to coordinate 
the tender for the Charlie Lake Septage Handling Facility with the re-tendering of the upgrades to 
the Charlie Lake Sewage Lagoons.  As EADC members are aware, earlier this year, the tender for 
the Lagoon upgrades came in over budget and the Board agreed to delay the project and retender 
it early in 2015, in the hopes of a more favorable tender result.  Administration believes it is 
important to try to get tender information for both the lagoon project and septage handling facility 
out early in the project planning season; however, since it is unknown whether the new services will 
be agreed to by residents, it will be important to include wording in the tender document that the 
Septage Handling Facility portion of the project is subject to approval of the Bylaw to create the 
service whereas the lagoon portion of the project is considered an upgrade and not a new service 
function. 
 
 

STRATEGIC PLAN RELEVANCE:  
 
The introduction of a sub-regional potable water and/or sewage function was not identified when 
the Strategic Plan was approved but has become a priority item due to the decision of the City of 
Fort St. John to close the Wastewater transfer station. 
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FINANCIAL CONSIDERATION(S): 
 
Expenditures for this portion of the project are related to the cost of statutory advertising and 
holding Community Conversation meetings throughout the region.   
 
Statutory Advertising -     $20,000 
 
Printing and Marketing costs -  $15,000 
 
Communications Consultant -  $15,000 
 
Total Estimated Costs   $50,000 
 
Currently, there are allocations for project “feasibility’ funding for the Tomslake & Farmington Water 
Stations that will be used and if these are fully spent, we would go back to request an increase from 
the Board.  If the services are approved then any feasibility funds spent will be collected from the 
taxpayer and replaced into the feasibility reserve.   Note that there is also $4,000 in the “Community 
Parks” function which is where the “water” systems are currently charged to. This amount was 
allocated for “voting” to create a new and proper water function so it is also available.   Since some 
of the costs carry to next year they can be budgeted in 2015 through the “Community Parks” 
function again if required. 
 

COMMUNICATIONS CONSIDERATION(S):  
 
Administration is recommending that fourteen (14) Community Conversation Meetings be held.  
This amount is consistent with the number of sessions held to discuss the Solid Waste Plan and 
provides residents with a reasonable number of opportunities to participate in the process.  
Additional sessions can be added as required. 
 
 

OTHER CONSIDERATION(S):  
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Updated:    July 17, 2014

ELECTORAL AREA DIRECTORS’ COMMITTEE

D I A R Y I T E M S

Item Status Notes Diarized


